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Technical Support

Symantec Technical Support maintains support centers globally. Technical

Support’s primary role is to respond to specific queries about product feature and

function, installation, and configuration. TheTechnical Support groupalso authors

content for our online Knowledge Base. The Technical Support group works

collaboratively with the other functional areas within Symantec to answer your

questions in a timely fashion. For example, the Technical Support group works

with Product Engineering and Symantec Security Response to provide alerting

services and virus definition updates.

Symantec’s maintenance offerings include the following:

■ A range of support options that give you the flexibility to select the right

amount of service for any size organization

■ A telephone and web-based support that provides rapid response and

up-to-the-minute information

■ Upgrade insurance that delivers automatic software upgrade protection

■ Global support that is available 24 hours a day, 7 days a week worldwide.

Support is provided in a variety of languages for those customers that are

enrolled in the Platinum Support program

■ Advanced features, including Technical Account Management

For information about Symantec’s Maintenance Programs, you can visit our Web

site at the following URL:

www.symantec.com/techsupp/ent/enterprise.html

Select your country or language under Global Support. The specific features that

are available may vary based on the level of maintenance that was purchased and

the specific product that you are using.

Contacting Technical Support

Customers with a current maintenance agreement may access Technical Support

information at the following URL:

www.symantec.com/techsupp/ent/enterprise.html

Select your region or language under Global Support.

Before contacting Technical Support, make sure you have satisfied the system

requirements that are listed in your product documentation. Also, you should be

at the computer on which the problem occurred, in case it is necessary to recreate

the problem.

www.symantec.com/techsupp/ent/enterprise.html
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When you contact Technical Support, please have the following information

available:

■ Product release level

■ Hardware information

■ Available memory, disk space, and NIC information

■ Operating system

■ Version and patch level

■ Network topology

■ Router, gateway, and IP address information

■ Problem description:

■ Error messages and log files

■ Troubleshooting that was performed before contacting Symantec

■ Recent software configuration changes and network changes

Licensing and registration

If your Symantec product requires registration or a license key, access our technical

support Web page at the following URL:

www.symantec.com/techsupp/ent/enterprise.html

Select your region or language underGlobal Support, and then select the Licensing

and Registration page.

Customer service

Customer service information is available at the following URL:

www.symantec.com/techsupp/ent/enterprise.html

Select your country or language under Global Support.

Customer Service is available to assist with the following types of issues:

■ Questions regarding product licensing or serialization

■ Product registration updates such as address or name changes

■ General product information (features, language availability, local dealers)

■ Latest information about product updates and upgrades

■ Information about upgrade insurance and maintenance contracts

■ Information about the Symantec Value License Program

www.symantec.com/techsupp/ent/enterprise.html
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■ Advice about Symantec's technical support options

■ Nontechnical presales questions

■ Issues that are related to CD-ROMs or manuals

Maintenance agreement resources

If you want to contact Symantec regarding an existing maintenance agreement,

please contact the maintenance agreement administration team for your region

as follows:

■ Asia-Pacific and Japan: contractsadmin@symantec.com

■ Europe, Middle-East, and Africa: semea@symantec.com

■ North America and Latin America: supportsolutions@symantec.com

Additional Enterprise services

Symantec offers a comprehensive set of services that allow you tomaximize your

investment in Symantec products and to develop your knowledge, expertise, and

global insight, which enable you to manage your business risks proactively.

Enterprise services that are available include the following:

These solutions provide early warning of cyber

attacks, comprehensive threat analysis, and

countermeasures to prevent attacks before they occur.

SymantecEarlyWarningSolutions

These services remove the burden of managing and

monitoring security devices and events, ensuring

rapid response to real threats.

Managed Security Services

Symantec Consulting Services provide on-site

technical expertise from Symantec and its trusted

partners. SymantecConsultingServices offer a variety

of prepackaged and customizable options that include

assessment, design, implementation,monitoring and

management capabilities, each focusedonestablishing

andmaintaining the integrity and availability of your

IT resources.

Consulting Services

Educational Services provide a full array of technical

training, security education, security certification,

and awareness communication programs.

Educational Services

contractsadmin@symantec.com
semea@symantec.com
supportsolutions@symantec.com


To access more information about Enterprise services, please visit our Web site

at the following URL:

www.symantec.com

Select your country or language from the site index.

www.symantec.com
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Symantec AntiVirus™

support for Windows Vista

overview

This chapter includes the following topics:

■ About Symantec AntiVirus support for Windows Vista

■ System requirements

About Symantec AntiVirus support forWindowsVista
Symantec AntiVirus provides protection against viruses and security risks for

managed and unmanaged clients that run on Windows Vista (32-bit and 64-bit

editions). Symantec AntiVirus clients that run on Windows Vista behave in

generally the same manner as Symantec AntiVirus clients that run on other

supported operating systems, such as Windows 2000/XP.

This guide contains information and procedures that are specific to installing,

using, and managing Symantec AntiVirus clients on Windows Vista. You should

review this informationbefore youbegin installing andusingSymantecAntiVirus

on Windows Vista.

You can perform the following actions from the Symantec AntiVirus client on

Windows Vista:

■ Establish and enforce antivirus security policies

■ Retrieve content updates, such as virus and security risk definitions

■ Control live viruses

■ Configure real-time scanning

1Chapter



■ Schedule virus and security risk scans

■ Analyze log events

See the Symantec AntiVirus Client Guide and the Symantec AntiVirus Installation

Guide for Symantec AntiVirus client information that applies to all the supported

operating systems, including Windows Vista.

System requirements
Symantec AntiVirus clients that run onWindows Vista have minimum operating

system requirements. Symantec AntiVirus on Windows Vista also requires that

specific ports are opened to permit communication between themanaged clients,

servers, Symantec System Center, and optional Symantec management

components.

For system requirements for the management components that run on Windows

2000, XP, or 2003, see the Symantec AntiVirus Installation Guide.

Open ports

When you install Symantec AntiVirus onWindows Vista, the installation process

automatically configures the Windows Firewall to allow exceptions for Symantec

AntiVirus processes that require access to your network and the Internet.

If yourmanaged clients run third-party firewall software, and youwant tomanage

these clients through the Symantec System Center, you must open the following

ports:

Allows communication between the Symantec System Center and

Symantec AntiVirus clients and servers.

TCP 2967

Allows remote installation of Symantec AntiVirus clients.TCP 139

Allows Discovery of Symantec AntiVirus servers that manage your

clients.

UDP 38293

You should permit Rtvscan.exe on all computers, permit Pds.exe on servers, and

permit the Symantec System Center to send and receive traffic through your

firewalls.

Operating system requirements

Pentium® IV or higher processors are recommended for all 32-bit and 64-bit

components. The following table lists the RAM, storage, and application

requirements for Symantec AntiVirus clients.

Symantec AntiVirus™ support for Windows Vista overview
System requirements
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Table 1-1 lists the system requirements for Symantec AntiVirus clients running

on Windows Vista.

Table 1-1 Operating System Requirements

RAM, storage, and applicationsComponent

■ 512 MB RAM

■ 255 MB disk space

Symantec AntiVirus 32-bit

■ 512 MB RAM

■ 255 MB disk space

■ Intel® processors that support Intel Extended

Memory 64 Technology (Intel EM64T)

■ AMD® 64-bit Opteron™ and Athlon™ processors

Symantec AntiVirus 64-bit

11Symantec AntiVirus™ support for Windows Vista overview
System requirements
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Installing Symantec

AntiVirus client

This chapter includes the following topics:

■ Before you install

■ Modifying Windows Firewall

■ Installing Symantec AntiVirus clients on Windows Vista

■ Installing Symantec AntiVirus clients on Windows Vista through Active

Directory Group Policy Object

Before you install
You have a number of options for installing client software:

■ Install from the Symantec System Center.

■ Install from the installation CD.

■ Install by using the standalone ClientRemote Install Tool.

■ Install by using Web-based installations and logon scripts.

■ Install by using Active Directory.

2Chapter



Note: You cannot install Symantec AntiVirus clients on Windows Vista by using

logon scripts when users log on to their computers as standard users. Standard

users do not run in elevated mode. As a workaround, you can run the installation

in the machine logon script instead of the user logon script. You can also deploy

or advertise the installation, at which point users can access the link to the

installation package and MSI automatically elevates privileges to perform the

installation.

This guide only covers pre-installation and installation tasks that are specific to

installing Symantec AntiVirus clients onWindows Vista. For general information

and installation procedures that apply to all supported operating systems, see the

Symantec AntiVirus Installation Guide.

Modifying Windows Firewall
Windows Vista contains a firewall that is enabled by default. If the firewall is

enabled, you might not be able to install client software remotely from the

Symantec System Center and other remote installation tools. Youmust configure

Windows Firewall to allow Symantec AntiVirus components to communicatewith

each other. You should configure Windows Firewall before you install Symantec

AntiVirus software. You can also temporarily disable Windows Firewall on your

clients before deploying Symantec AntiVirus.

To configure Windows Firewall to allow you to install Symantec AntiVirus client

on Windows Vista, you should configure Enable File and Printer Sharing.

Note: Symantec AntiVirus also automatically modifies Windows Firewall during

installation on Window Vista to allow specific processes access to your network

and the Internet. You are not required to make any further modifications.

To Enable File and Printer Sharing

1 On the Windows Vista taskbar, click Start > Control Panel.

2 In the Control Panel window, click Security.

3 In the Security window, clickWindows Firewall.

4 In the Windows Firewall dialog box, on the Exceptions tab, check File and

Printer Sharing.

5 Click OK.

Installing Symantec AntiVirus client
Modifying Windows Firewall
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Installing Symantec AntiVirus clients on Windows
Vista

You have a number of options for installing client software, which include the

following:

■ Install the software from the Symantec System Center console.

■ Install the software from the installation CD.

■ Install client software through Active Directory Group Policy Object (GPO)

from an administrative install image.

Note: Symantec AntiVirus does not support migrating over existing or future

versions of Symantec AntiVirus client on Windows Vista. You must uninstall all

versions of Symantec AntiVirus client onWindows Vista before you install a new

version of Symantec AntiVirus on Windows Vista.

The easiest way to deploy client software is to use the ClientRemote Install Tool

in the Symantec System Center console. With this tool in your production or test

environment, you can install Symantec AntiVirus client software to multiple

clients at the same time without having to visit each computer individually.

Note: You must use a server running Symantec AntiVirus version 10.1.5.5000 or

higher to use the ClientRemote tool to deploy Symantec AntiVirus clients on

Windows Vista. Deployment from legacy Symantec AntiVirus servers is not

supported.

You can manage your Symantec AntiVirus Windows Vista-based clients using a

server running Symantec AntiVirus 10.1 or earlier, but you must browse to a

custom installation path during RemoteClient tool deployment to do so.

The latest version of the ClientRemote Install Tool can automatically detect valid

client installation packages that are located in newly installed SymantecAntiVirus

server computers. You must install the latest versions of the Symantec System

Center andSymantecAntiVirus server in your environment. TheSymantecSystem

Center installation contains the latest version of the ClientRemote Install Tool

that lets you deploy Symantec AntiVirus clients that run on Windows Vista. The

latest Symantec AntiVirus server contains the installation packages that the

ClientRemote Install Tool uses to deploy the Symantec AntiVirus client to

computers running Windows Vista.

15Installing Symantec AntiVirus client
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Note: Symantec AntiVirus requires elevated privileges to install.

If youwant to use theClientRemote Install Tool from the Symantec SystemCenter

to deploy Symantec AntiVirus on your client computers, then you must do the

following on each client computer:

■ Disable the File Sharing Wizard by using the folder's Options>View menu.

■ Enable Network Discovery by using the Network and Sharing center.

■ Enable the built-in Administrator account and assign it a password.

Note: The Windows Vista feature User Access Control (UAC) blocks local

administrative accounts from remotely accessing remote administrative shares

such as C$ and Admin$. To use the ClientRemote Install Tool in this scenario, you

should use a Domain Administrative account if the target client computer is part

of an Active Directory domain.

To verify that you have elevated privileges

1 Click Start >Run....

2 Type <targetmachine name>\C$

If you can access the C$ remote administrative share, then your privileges

are elevated.

To install Symantec AntiVirus clients onWindows Vista from the Symantec System

Center

1 In the Symantec SystemCenter console, in the left pane, right-click the server

group that contains the antivirus server that youwant tomanage your clients.

2 If necessary, click Unlock ServerGroup, and then unlock the server group.

3 In the left pane, click the primary server so that it remains highlighted.

4 On the Tools menu, click ClientRemote Install.

5 In the Welcome panel, click Next.

6 In the Select Install Source Location panel, do one of the following:

■ If you are using the latest version of SymantecAntiVirus server tomanage

your clients, check Default.

■ If you are using a legacy version of Symantec AntiVirus server to manage

your clients, check Deploy Install Path, and then click Browse to specify

the C:\Program Files\SAV\CLT-INST\WIN32VISTA or the C:\Program

Files\SAV\CLT-INST\WIN64VISTA folder.

Installing Symantec AntiVirus client
Installing Symantec AntiVirus clients on Windows Vista
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7 Click Next.

8 In the Select Computers panel, under AntiVirus Servers on the right side,

select a computer to act as the parent server (your primary server).

9 Under Available Computers on the left side, expandMicrosoft windows

network, expand a group, and then select a client computer.

10 Click Add.

You may need to provide an administrator user name and password to add a

client computer. Once the computer is added, it will appear under the

AntiVirus parent server in the right pane.

11 Continue to select and add client computers until all of the clients that you

want to manage are added, and then click Finish.

12 Click OK.

13 In the Status of Remote Client Installation(s) panel, when the remote

installation is finished, click Done.

14 After a few minutes, in the Symantec System Center console, on the main

menu bar, click Actions >Refresh.

The client computer appears in the right pane when the client software is

fully installed, which may take several minutes.

15 On the main menu bar, click Console > Save.

To install an unmanaged Symantec AntiVirus client on Windows Vista from the

installation CD

1 Insert the Symantec AntiVirus CD into the CD-ROM drive.

2 In theSymantecAntiVirus panel, click InstallSymantecAntiVirus, and then

in the next panel, click Install SymantecAntiVirus Client.

3 In the Welcome panel, click Next.

4 In the License Agreement panel, click I accept the terms in the license

agreement, and then click Next.

5 In the Setup Type panel, click Complete, and then click Next.

17Installing Symantec AntiVirus client
Installing Symantec AntiVirus clients on Windows Vista



6 In the Network Setup Type panel, click Unmanaged, and then click Next.

7 In the Protection Options panel, do the following:

■ If you want to enable Auto-Protect, ensure that Auto-Protect is checked.

■ If you want to run LiveUpdate at the end of the installation, ensure that

Run LiveUpdate is checked.

■ If you want to disable Windows Defender, ensure that Disable Windows

Defender is checked.

8 Click Next.

9 In the Ready to Install the Program panel, click Install.

10 If you chose to run LiveUpdate after installation, do the following:

■ Follow the instructions in the LiveUpdate Wizard.

■ When LiveUpdate is finished, click Finish.

11 In the Symantec AntiVirus panel, click Finish.

Installing Symantec AntiVirus clients on Windows
Vista through Active Directory Group Policy Object

You can install Symantec AntiVirus clients on Windows Vista by using by using

a Windows 2000/2003 Active Directory Group Policy Object.

Installing Symantec AntiVirus client
Installing Symantec AntiVirus clients on Windows Vista through Active Directory Group Policy Object
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Confirm that your DNS server is set up correctly. The correct setup is very

important becauseActiveDirectory relies heavily on yourDNS server for computer

communication. To test the setup, from a client computer that has joined the

domain, ping theWindows Vista Active Directory computer, and then ping in the

opposite direction. Use the fully qualified domain name; the use of the computer

name alone does not call for a new DNS lookup. Use the following format:

ping computername.fullyqualifieddomainname.com

Note: If User Access Control (UAC) is enabled, you must enable Always install

with elevated privileges for Computer Configuration and User Configuration to

install Symantec AntiVirus through a Group Policy Object. Setting these options

allows all Windows Vista users, including standard users, to install Symantec

AntiVirus.

To install SymantecAntiVirus clients onWindowsVista by usingActiveDirectory

Group Policy Object, you must do the following:

■ Create the administrative install image

■ Stage the administrative install image

■ Create a GPO software distribution

■ Ensure that the GPO runs with elevated privileges

To create the administrative install image

1 Copy the SAVVISTA or SAVWin64VISTA folder to your computer.

2 Do one of the following:

■ From a command prompt, navigate to the SAVVISTA folder and type:

msiexec /a "Symantec AntiVirus.msi"

■ From a command prompt, navigate to the SAVWin64VISTA\x64 folder

and type:

msiexec /a "Symantec AntiVirus Win64.msi"

3 In the Welcome panel, click Next.

4 In the Network Location panel, enter the location where you want to create

the administrative install image, and then click Install.

5 Click Finish.

The administrative install image is created in the location that you specified.

19Installing Symantec AntiVirus client
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To stage the administrative install image

1 CopyGRC.DATand thepki folder fromtheSymantecAntiVirusServer location

c:\Program Files\Symantec Client Security\Symantec AntiVirus\CLT-INST\

Win32 to the CDVista\SAVVISTA or CDVista\SAVWin64VISTA folder from

which you want to install.

2 Copy the administrative install image that you created to the CDVista\

SAVVISTA or CDVista\SAVWin64VISTA folder from which you want to

install.

3 From aWindows 2000/2003 Active Directory computer, share the CDVista\

SAVVISTA or CDVista\SAVWin64VISTA folder that contains the Symantec

AntiVirus client for Windows Vista install files, GRC.DAT, and pki folder.

To create a GPO software distribution

1 From aWindows 2000/2003 Active Directory computer, on the Windows

Taskbar, click Start > Programs >Administrative Tools >GroupPolicy

Management.

2 In the console tree, right-click the organizational unit to which you plan to

deploy clients, and then click Create and Link aGPOHere.

3 Type the following as the new policy name:ElevatedGroupPolicy, then click

OK.

4 Right-click ElevatedGroupPolicy, and then click Edit.

5 Under the Computer Configuration, expand Software Settings.

6 Right-click Software installation, and then click New>Package.

7 In the Open dialog box, type the Universal Naming Convention (UNC) path

or browse to the shared Win32 folder that contains the MSI package.

If you use the UNC path to the shared folder, use the format of the following

example:

\\<server name>\Win32\Symantec AntiVirus.msi

8 Click the Symantec AntiVirus.msi file, and then click Open.

9 Click Assigned, and then click OK.

The package is listed in the right pane of the Group Policy window.

Installing Symantec AntiVirus client
Installing Symantec AntiVirus clients on Windows Vista through Active Directory Group Policy Object
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To ensure that the GPO runs with elevated privileges

1 On the Windows Taskbar, click Start > Programs >Administrative Tools >

GroupPolicyManagement.

2 Under Computer Configuration, expand Administrative Templates >

Windows Components.

3 ClickWindows Installer.

4 In the right pane, double click Always install with elevated privileges.

5 Check Enable.

6 If the option is present, check Check to force setting on; uncheck to force

setting off.

Some organizational units may not show this option.

7 Click Apply, and then click OK.

8 Under User Configuration, expand Administrative Templates >Windows

Components.

9 ClickWindows Installer.

10 In the right pane, double click Always install with elevated privileges.

11 Check Enable.

12 If the option is present, check Check to force setting on; uncheck to force

setting off.

Some organizational units may not show this option.

13 Click Apply, and then click OK.

14 Close the Group Policy window, and then click Close or OK.

15 Close Group Policy Management.

16 To apply the changes, on the Windows taskbar, click Start >Run.

17 In the Open box, type the following text:

gpupdate

18 Click OK.

When the client computer starts, the Symantec AntiVirus client software

package is installed before the logon.

21Installing Symantec AntiVirus client
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Managing Symantec

AntiVirus client onWindows

Vista

This chapter includes the following topics:

■ About managing Symantec AntiVirus client on Windows Vista

■ What you need to manage Symantec AntiVirus clients on Windows Vista

About managing Symantec AntiVirus client on
Windows Vista

SymantecAntiVirusmanaged clients that runonWindowsVistamust bemanaged

by Symantecmanagement components that are installed on supported operating

systems. Symantec AntiVirus server, the Symantec System Center, and other

Symantec management components are not supported on Windows Vista. You

can install these components on supported operating systems, such as Windows

2000 or XP. After you install these components, you can use the components to

manage your Symantec AntiVirus clients that run on Windows Vista.
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Note: The latest version of the Symantec AntiVirus server installation contains

new client installation packages for 32-bit and 64-bit computers, and forWindows

Vista and pre-Vista computers. When you install the Symantec AntiVirus client

by using the latest version of the ClientRemote Install Tool, the tool determines

the client's operating system and installs the appropriate installation package to

the client. The additional client installation packages in Symantec AntiVirus

server increase the amount of disk space that the server uses on your computer

by approximately 60 MB.

For information on installing and configuring the Symantec AntiVirus server and

management components, see the following guides:

■ Symantec AntiVirus Administrator's Guide

■ Symantec AntiVirus Installation Guide

■ Reporting User's Guide

■ Endpoint Compliance Implementation Guide

■ Symantec Central Quarantine Administrator's Guide

What you need tomanage Symantec AntiVirus clients
on Windows Vista

You can manage Symantec AntiVirus clients that run onWindows Vista from the

Symantec System Center. You must assign a Symantec AntiVirus server to act as

the parent management server for the Symantec AntiVirus client. You can assign

a parent management server when you are installing the client.

Note: You cannot install Symantec AntiVirus server or the Symantec System

Center on Windows Vista. You must install these components on supported

operating systems, such as Windows 2000 or XP.

You need the followingmanagement components tomanage Symantec AntiVirus

on Windows Vista. These components are installed by default when you install

the Symantec System Center:

Required to manage antivirus protection on client

computers.

Symantec AntiVirus Snap-in

Managing Symantec AntiVirus client on Windows Vista
What you need to manage Symantec AntiVirus clients on Windows Vista
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Required to push the Symantec AntiVirus client

installation to remote computers that run Windows

Vista. You must use the latest version of the Client

Remote Install Tool to remotely deploy Symantec

AntiVirus clients running on Windows Vista. You

must also upgrade your Symantec AntiVirus server

to automatically deploy Symantec AntiVirus clients

on Windows Vista.

Note: The latest versions of the ClientRemote Install

Tool and Symantec AntiVirus server are included in

the installation CD, and can also be downloaded from

the designated download location.

ClientRemote Install Tool

Othermanagement components are installed bydefault and canbeused tomanage

clients that run on pre-Vista operating systems. If your network also consists of

Windows 2000 or XP computers, you should install these other management

components so that you can fully manage all your computers.

If you elect not to install any of thesemanagement componentswith the Symantec

System Center, you can run the Symantec System Center installation later and

select them.

See the Symantec AntiVirus Administrator's Guide for more information on how

to manage Symantec AntiVirus clients on Windows Vista.

25Managing Symantec AntiVirus client on Windows Vista
What you need to manage Symantec AntiVirus clients on Windows Vista



Managing Symantec AntiVirus client on Windows Vista
What you need to manage Symantec AntiVirus clients on Windows Vista

26



Using Symantec AntiVirus

client on Windows Vista

This chapter includes the following topics:

■ About the Symantec AntiVirus client on Windows Vista

About the Symantec AntiVirus client on Windows
Vista

Symantec AntiVirus clients that run on Windows Vista function in a similar way

to clients that run on previously supported operating systems, such as Windows

2000 and XP. Any differences are a result of new features of the Windows Vista

operating system.

Table 4-1 lists Symantec AntiVirus features that function differently onWindows

Vista-based computers.

Table 4-1 Symantec AntiVirus client on Windows Vista unique features

DescriptionFunction

Demonstrates the following new behavior:

■ Runs in silent mode for standard users. Users with administrator

privileges continue to run LiveUpdate interactively.

■ Standard users can run LiveUpdate from the main user interface

on unmanaged Symantec AntiVirus clients.

■ Default location of risk definitions changed fromC:\ProgramFiles\

Common Files\Symantec Shared\VirusDefs to C:\ProgramData\

Symantec\Definitions\VirusDefs

LiveUpdate
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Table 4-1 Symantec AntiVirus client on Windows Vista unique features

(continued)

DescriptionFunction

This Windows service needs to be turned on for client deployment.

The Remote Registry service is turned off by default on Windows

Vista. The SymantecAntiVirus ClientRemote tool automatically turns

this service on if it is off. After installation completes, Symantec

AntiVirus installation turns the service off.

Depending on the speed of the target client computer and other timing

issues, the ClientRemote tool may prompt you that the target client

computer does not have the Remote Registry service running. If you

receive this prompt, adding the client computer a second time often

resolves the problem.

If the Remote Registry service is removed, then remote client

installation fails.

Remote Registry

service

Demonstrates the following behavior:

■ SymantecAntiVirus client installation turns offWindowsDefender

spyware protection by default. Windows Defender is turned off to

prevent compatibility issues that occur when more than one

antispyware application is installed on the same computer.

You can override this behavior by unchecking theDisableWindows

Defender checkbox during the client installation.

■ Symantec AntiVirus client installation automatically creates

Windows Firewall exceptions for Rtvscan.exe and ccapp.exe, which

allows these processes access to your network and the Internet.

You should not delete these firewall exceptions. Deleting these

exceptions can prevent your clients from receiving definitions and

policy updates, and can prevent your clients from sending and

receiving email.

■ Updates the Malware protection category with the status of Virus

protection and Spyware and other malware protection categories.

Windows Security

Center

Blocks local administrative accounts from remotely accessing remote

administrative shares such as C$ and Admin$.

User Account

Control (UAC)
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Table 4-1 Symantec AntiVirus client on Windows Vista unique features

(continued)

DescriptionFunction

Determines the operating system of the computer and installs the

appropriate client installation package that is available on the

Symantec AntiVirus server. The latest version of the ClientRemote

Install Tool lets you deploy Symantec AntiVirus client to multiple

client operating systems including Windows Vista.

Note: The Symantec AntiVirus client installation packages for

Windows Vista are available in the latest version of Symantec

AntiVirus server. You must upgrade your Symantec AntiVirus server

to automatically deploy SymantecAntiVirus clients onWindowsVista.

The latest version of Symantec AntiVirus server is included in the

installation CD, or can be downloaded from the designated download

location.

The following client installation packages are found on the Symantec

AntiVirus server and are made available to the ClientRemote Install

Tool:

■ 32-bit Windows pre-Vista client

■ 64-bit Windows pre-Vista client

■ 32-bit Windows Vista client

■ 64-bit Windows Vista client

ClientRemote

Install Tool and

the installation

packages available

on Symantec

AntiVirus Server

Successfully updates definitions on the endpoint, but you receive a

Program Compatibility Assistant error that states that the program

did not install correctly. You should ignore this error message.

Intelligent

Updater

Demonstrates the following new behavior:

■ If a scan orAuto-Protect detects a security riskwhen you are logged

out of the computer, you are notified of the risk when you log on

to the computer.

■ Auto-Protect notifications appear in the correct user session.

Risk notifications
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Table 4-1 Symantec AntiVirus client on Windows Vista unique features

(continued)

DescriptionFunction

Demonstrates the following new behavior:

■ Requires the Symantec AntiVirus service to be running to perform

any scans.

■ Continues administrator-scheduled scans when the user logs out.

Stops user-scheduled scans when the user logs out.

■ For user-scheduled scans that initiate when the user is logged on,

the scan stops when the user logs out.

■ For user-scheduled scans that initiate when the user is not logged

but are configured to run when the user is logged off, the scan

behaves like an administrator-scheduled scan.

Scans

Demonstrates the following new behavior:

■ Requires theEventManager service to be running forAuto-Protect

to function.

■ Allows standarduserswith elevatedprivileges to enable anddisable

Auto-Protect from the system tray icon. When a standard user

attempts to enable or disable Auto-Protect from the system tray

icon, a User Account Control windows appears and the user must

enter the administrator password to continue.

■ Stops and restarts the Symantec AntiVirus service when

Auto-Protect is upgraded or reloaded.

■ Prevents you from shutting down Auto-Protect after it is started.

Auto-Protect starts up with the service, but remains running until

you stop it manually or you shut down your computer.

■ Allows Auto-Protect to be updated independently of other

components. If Auto-Protect can be updated through another

product installation, the RTVScan service will stop and restart to

update the Auto-Protect interfaces.

Auto-Protect

Removes ability to load and unload service from the main user

interface.

Symantec

AntiVirus service

Demonstrates the following new behavior:

■ Removes the option to purge logs or change the log purge options

from the main user interface for standard users.

■ Changes the default logs directory from C:\Documents and

Settings\AllUsers\ApplicationData\Symantec\SymantecAntiVirus

Corporate Edition\7.5\Logs to C:\ProgramData\Symantec\

Symantec AntiVirus Corporate Edition\7.5\Logs

Logs
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Table 4-1 Symantec AntiVirus client on Windows Vista unique features

(continued)

DescriptionFunction

Shows virtualized paths to standard users in Symantec AntiVirus

notifications, histories, and views. Users who log on to Vista as

administrators view the actual paths.

Virtualized folders

Does not prompt you if there are items in the Quarantine when you

uninstall Symantec AntiVirus. Any items in the Quarantine are not

deleted by default.

Quarantine

Changes the default license directory fromC:\ProgramFiles\Common

Files\SymantecShared\Licenses toC:\ProgramData\SymantecShared\

Licenses

If your product does not require a content license, you can ignore this

information.

Licenses
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